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Overview
Make computers easier and more comfortable to use with accessibility features and utilities built right into Microsoft® Windows Me.

Display and Readability
Windows Me includes options to increase visibility of items on the computer screen including:

· Display options—choose screen elements and schemes, adjust the screen area and font sizes, select a screen saver, change the size and color of icons, and smooth the edges of screen fonts.

· Icon size—make icons larger for visibility, or smaller for increased screen space.

· Screen resolution—change pixel count to enlarge objects on screen.

· High contrast schemes—select color combinations that are easier to see.

· Microsoft Magnifier—enlarge portion of screen for better visibility.
Sounds and Speech
Windows Me includes options to make computer sounds easier to hear or distinguish—or, you can choose visual alternatives to sound. Options you can adjust include:

· Sound options—assign sounds to events, choose sound schemes, adjust sound volume, show volume control in the taskbar, and select audio devices.

· ShowSounds—display captions for speech and sounds.

· SoundSentry—display visual warnings for system sounds.

· Notification—Get sound or visual cues when accessibility features are turned on or off.

Keyboard and Mouse

In Windows Me you can choose a number of options to make your keyboard and mouse faster and easier to use. Options you can adjust include:

Mouse options: 

· Choose right-handed or left-handed mouse button configuration

· Adjust the double-click speed

· Change the pointer scheme

· Adjust the pointer speed and acceleration rate.

Keyboard options: 

· Adjust the character repeat rate and repeat-delay speed.

· StickyKeys—allow pressing one key at a time (rather than simultaneously) for key combinations.

· FilterKeys—ignore brief or repeated keystrokes and slow down the repeat rate.

· ToggleKeys—hear tones when pressing certain keys.

· MouseKeys—move the mouse pointer using the numerical keypad.

Accessibility Wizard and Utilities

The Accessibility Wizard can help new users quickly and easily set up groups of accessibility options that address visual, hearing and dexterity needs all in one place. The Accessibility Wizard asks questions about accessibility needs. Then, based on the answers, it configures utilities and settings for individual users. The Accessibility Wizard can be run again at any time to make changes, or changes can be made to individual settings through Control Panel. 

To learn about the Accessibility Wizard, see:

· Opening the Accessibility Wizard

Windows Me Accessibility Utilities:

· Magnifier—a display utility that makes the computer screen more readable by creating a separate window that displays a magnified portion of the screen.

· On-Screen Keyboard—displays a virtual keyboard on the computer screen that allows people to type data by using a pointing device or joystick.

Using Assistive Technology

If you use assistive technology, be sure to contact your assistive technology manufacturer to check compatibility with Windows XP and to learn how to adjust your settings to optimize compatibility.

How to Make Windows Me More Accessible

Accessibility utilities and options in Microsoft Windows Me are installed by default; but to optimize them to your personal needs and preferences, you must first configure them. There are several ways you can do this:

Customizing Accessibility Options by Using the Accessibility Wizard

One of the best ways to get started using the accessibility features of Windows Me is to run the Accessibility Wizard. The Accessibility Wizard asks you questions about your accessibility needs. Then, based on your answers, it configures utilities and settings for you. You can run the Accessibility Wizard again at any time to make changes, or you can use Control Panel as explained below. With the Accessibility Wizard, you can set options specifically for: 

· People who are blind or have difficulty seeing things on screen. 

· People who are deaf or have difficulty hearing sounds from the computer. 

· People who have difficulty using the keyboard or mouse. 

Customizing Accessibility Options Through Control Panel

After your initial configuration by using the Accessibility Wizard, you can adjust the accessibility features through Control Panel. In Windows Me, Control Panel contains seven settings programs related to accessibility features. 

You can access most accessibility settings by selecting the Accessibility Options icon, or you can zero-in on a particular settings group by using one of the other Control Panel icons: 

· Display 

· Folder Options

· Passwords

· Internet Options 

· Keyboard 

· Mouse 

· Sounds and Multimedia 

· Users 

Using the Accessibility Wizard

One of the best ways to get started using the accessibility features of Windows Me is to run the Accessibility Wizard. The Accessibility Wizard asks you questions about your accessibility needs. Then, based on your answers, it configures utilities and settings for you. You can run the Accessibility Wizard again at any time to make changes, or you can use Control Panel as explained below. 

Customizing With Accessibility Wizard

With the Accessibility Wizard, you can set options specifically for: 

· People who are blind or have difficulty seeing things on screen. 

· People who are deaf or have difficulty hearing sounds from the computer. 

· People who have difficulty using the keyboard or mouse. 

Opening Accessibility Wizard

	
	Mouse actions
	Keyboard actions

	
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows® logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.


To Continue

To complete the Accessibility Wizard, see one or more of the following Step by Step Guides:

· Changing the Font Size of Text on the Screen

· Switching to a Lower Screen Resolution to Increase the Size of Items on the Screen

· Changing the Size of Items on the Screen

· Disabling Personalized Menus

· Setting Options for People Who Are Blind or Have Difficulty Seeing Things on the Screen

· Setting Options for People Who Are Deaf or Have Difficulty Hearing Sounds from the Computer

· Setting Options for People Who Have Difficulty Using the Keyboard or Mouse

· Setting Administrative Options

· Restoring Default Settings

· Saving Accessibility Wizard Settings to a File

Quick Reference: Opening Accessibility Wizard

	Start Menu Procedures

· Select the Start button, or press CTRL+ESC.

· Select Programs.

· Select Accessories.

· Select Accessibility.

· Select Accessibility Wizard.
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	Accessibility Wizard Procedures

· Select Next or press N to continue through the wizard.
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Changing the Font Size of Text on the Screen

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

· Select Use large window titles and menus.

· Select Next to continue through the wizard.
	In the Text Size dialog box:

· Select Use large window titles and menus by using the UP ARROW or DOWN ARROW key.

· Press N to continue through the wizard (use the arrow keys and ENTER to select the appropriate options).

	4
	In the Completing the Accessibility Wizard dialog box:

· Select Finish to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Switching to a Lower Screen Resolution to Increase the Size of Items on the Screen

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

Select the smallest text you can read.

· Select Next.
	In the Text Size dialog box:

· Select the smallest text you can read by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

	4
	In the Display Settings dialog box:

· Select the Switch to a lower screen resolution check box.

Note  If the option appears dimmed, it is unavailable because your display is already at the lowest screen resolution possible.

· Select Next to continue through the wizard.


	In the Display Settings dialog box:

· Select Switch to a lower screen resolution check box by pressing S.

Note  If the option appears dimmed, it is unavailable because your display is already at the lowest screen resolution possible.

· Press ENTER to continue through the wizard (use the arrow keys to select the appropriate options).

	5
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Changing the Size of Items on the Screen

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

· Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

	4
	In the Display Settings dialog box:

· Ensure that the Change the font size check box is selected. 

· If it is not selected, select this check box.

Select Next.
	In the Display Settings dialog box:

· Ensure that the Change the font size check box is selected.

If it is not selected:

·  Press C.

· Press ENTER.

	5
	In the Set Wizard Options dialog box:

· Select the I am blind or have difficulty seeing things on screen check box.

· Select Next.
	In the Set Wizard Options dialog box:

· Select the I am blind or have difficulty seeing things on screen check box by pressing L. 

· Press ENTER.


(continued)

	6
	In the Scroll Bar and Window Border Size dialog box:

· Select the scroll bar and window border size you want.

· Select Next.
	In the Scroll Bar and Window Border Size dialog box:

· Select the scroll bar and window border size you want by using the LEFT ARROW or RIGHT ARROW key.

· Press ENTER.

	7
	In the Icon Size dialog box:

· Select the icon size you want.

· Select Next to continue through the wizard.
	In the Icon Size dialog box:

· Select the icon size you want by using the LEFT ARROW or RIGHT ARROW keys.

· Press ENTER to continue through the wizard (use the arrow keys and ENTER to select the appropriate options).

	8
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Disabling Personalized Menus

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

· Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

	4
	In the Display Settings dialog box:

· Select the Disable personalized menus check box.

· Select Next to continue through the wizard.
	In the Display Settings dialog box:

· Select the Disable personalized menus check box by pressing D.

· Press ENTER to continue through the wizard (use the arrow keys and ENTER to select the appropriate options).

	5
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Setting Options for People Who Are Blind or Have Difficulty Seeing Things on the Screen

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press N.

	4
	In the Display Settings dialog box:

· Ensure that the Change the font size check box is selected. 

If it is not selected:

· Select this check box.

· If you want to use Microsoft Magnifier, select the Use Microsoft Magnifier check box.

· Select Next.
	In the Display Settings dialog box:

· Ensure that the Change the font size check box is selected.

If it is not selected:

· Press C.

If you want to use Microsoft Magnifier, 
press U. 

· Press ENTER.


(continued)

	5
	In the Set Wizard Options dialog box:

· Select the I am blind or have difficulty seeing things on screen check box.

· Select Next to continue through the wizard.
	In the Set Wizard Options dialog box:

· Select the I am blind or have difficulty seeing things on screen check box by pressing L. 

· Press ENTER to continue through the wizard (use the arrow keys and ENTER to select the appropriate options).

	6
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Setting Options for People Who Are Deaf or Have Difficulty Hearing Sounds from the Computer

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

· Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

	4
	In the Display Settings dialog box:

· Select the options you want.

· Select Next.
	In the Display Settings dialog box:

· Select the options you want.

· Press ENTER.


(continued)

	5
	In the Set Wizard Options dialog box:

· Select the I am deaf or have difficulty hearing sounds from the computer check box.

· Select Next to continue through the wizard.
	In the Set Wizard Options dialog box:

· Select the I am deaf or have difficulty hearing sounds from the computer check box by pressing D. 

· Press ENTER to continue through the wizard (use the arrow keys to select the appropriate options).

	6
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Setting Options for People Who Have Difficulty Using the Keyboard or Mouse

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

· Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

	4
	In the Display Settings dialog box:

· Select the options you want.

· Select Next.
	In the Display Settings dialog box:

· Select the options you want. 

· Press ENTER.

	5
	In the Set Wizard Options dialog box:

· Select the I have difficulty using the keyboard or mouse check box.

· Select Next to continue through the wizard.
	In the Set Wizard Options dialog box:

· Select the I have difficulty using the keyboard or mouse check box by pressing K. 

· Press ENTER to continue through the wizard (use the arrow keys to select the appropriate options).

	6
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Setting Administrative Options

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

· Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

	4
	In the Display Settings dialog box: 

· Select the options you want.

· Select Next.
	In the Display Settings dialog box:

· Select the options you want. 

· Press ENTER.

	5
	In the Set Wizard Options dialog box:

· Select the I want to set administrative options check box.

· Select Next to continue through the wizard.
	In the Set Wizard Options dialog box:

· Select the I want to set administrative options check box by pressing A. 

· Press ENTER to continue through the wizard (use the arrow keys and ENTER to select the appropriate options).

	6
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Restoring Default Settings

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER.

	3
	In the Text Size dialog box:

· Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

	4
	In the Display Settings dialog box:

· Select Next.
	In the Display Settings dialog box:

· Press ENTER.

	5
	In the Set Wizard Options dialog box:

· Select Restore Default Settings.

· Select Next to continue through the wizard.
	In the Set Wizard Options dialog box:

· Select Restore Default Settings by pressing R. 

· Press ENTER to continue through the wizard.

	6
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Saving Accessibility Wizard Settings to a File

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Accessibility Wizard.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to Accessibility Wizard, and then press ENTER.

	2
	In the Welcome to the Accessibility Wizard dialog box:

· Select Next to continue through the wizard.
	In the Welcome to the Accessibility Wizard dialog box:

· Press ENTER to continue through the wizard.

	3
	In the Text Size dialog box:

· Select the text size option you want.

· Select Next.
	In the Text Size dialog box:

· Select the text size option you want by using the UP ARROW or DOWN ARROW key.

· Press N.

	4
	In the Display Settings dialog box:

· Select the options you want.

· Select Next.
	In the Display Settings dialog box:

· Select the options you want.

· Press ENTER.

	5
	In the Set Wizard Options dialog box:

· Select the statements that apply to you.

· Select Next to continue through the wizard.
	In the Set Wizard Options dialog box:

· Select the statements that apply to you. 

· Press ENTER to continue through the wizard.

	6
	In the Save Settings to File dialog box:

· Select Save Settings.
	In the Save Settings to File dialog box:

· Select Save Settings by pressing S.


(continued)

	7
	In the Save As dialog box:

· Specify a file name and location.

· Select Save.

· Select Next to continue through the wizard.
	In the Save As dialog box:

· Specify a file name and location.

· Press ALT+S.

· Press ENTER to continue through the wizard.

	8
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.
	In the Completing the Accessibility Wizard dialog box:

· Press ENTER to save your changes and exit the wizard.


Using On-Screen Keyboard

On-Screen Keyboard is a utility that displays a virtual keyboard on the computer screen that allows people with mobility impairments to type using just the mouse. Besides providing a minimum level of functionality for some people with mobility impairments, On-Screen Keyboard can also help people who do not know how to type. 

Step by Step Guides for On-Screen Keyboard can help you with: 

· Opening the on-screen keyboard. 

· Selecting a keyboard layout. 

· Selecting the font for on-screen keyboard keys. 

· Using an audible click. 

· Activating hovering mode. 

· Activating clicking mode. 

Opening the On-Screen Keyboard

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select On-Screen Keyboard.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, select OK.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to On-Screen Keyboard, and then press ENTER.

Note  A message box with a link to more information about accessibility utilities may appear. To close the box, press ENTER.


To Continue

To continue customizing On-Screen Keyboard, see one or more of the following Step by Step Guides:

· Selecting a Keyboard Layout

· Selecting the Font for On-Screen Keyboard Keys

· Using an Audible Click

· Activating Hovering Mode

· Activating Clicking Mode

Quick Reference: Opening On-Screen Keyboard

	Start Menu Procedures

· Select the Start button, or press CTRL+ESC.

· Select Programs.

· Select Accessories.

· Select Accessibility.

· Select On-Screen Keyboard.
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	On-Screen Keyboard Procedures

· Select keys by using the mouse.
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 Selecting a Keyboard Layout 

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select On-Screen Keyboard.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, select OK.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to On-Screen Keyboard, and then press ENTER.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, press ENTER.

	2
	In the On-Screen Keyboard window, on the Keyboard menu::

· Select the keyboard layout you want.
	In the On-Screen Keyboard window:

· Display the Keyboard menu by pressing ALT+K.

· Select the keyboard layout you want by pressing the UP ARROW or DOWN ARROW key.

· Press ENTER.


Selecting the Font for On-Screen Keyboard Keys

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select On-Screen Keyboard.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to On-Screen Keyboard, and then press ENTER.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, press ENTER.

	2
	In the On-Screen Keyboard window, on the Settings menu:

· Select Font.
	In the On-Screen Keyboard window:

· Display the Settings menu by pressing ALT+S.

· Select Font by pressing F.

	3
	In the Font dialog box:

· Select a font, font style, and font size.
	In the Font dialog box:

· Select a font, font style, and font size by using the UP ARROW, DOWN ARROW, and TAB keys.

	4
	· Select OK.
	· Press ENTER.


Using an Audible Click

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select On-Screen Keyboard.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to On-Screen Keyboard, and then press ENTER.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, press ENTER.

	2
	In the On-Screen Keyboard window, on the Settings menu:

·  Select Use Click Sound.
	In the On-Screen Keyboard window:

· Display the Settings menu by pressing ALT+S.

· Select Use Click Sound by pressing U.


Activating Hovering Mode

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select On-Screen Keyboard.

Note  A message box with a link to more information about On-Screen Keyboard may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to On-Screen Keyboard, and then press ENTER.

Note  A message box with a link to more information about On-Screen Keyboard may appear. To close the box, press ENTER.

	2
	In the On-Screen Keyboard window, on the Settings menu:

· Select Typing Mode.
	In the On-Screen Keyboard window:

· Display the Settings menu by pressing ALT+S.

· Select Typing Mode by pressing T.

	3
	In the Typing Mode dialog box:

· Select Hover to select.
	In the Typing Mode dialog box:

· Select Hover to select by pressing H.

	4
	To adjust the minimum hover time:

· Use the UP ARROW or DOWN ARROW key.
	To adjust the minimum hover time:

· Press the TAB key to move to the Seconds box.

· Use the UP ARROW or DOWN ARROW key.

	5
	To close the Typing Mode dialog box:

· Select OK.
	To close the Typing Mode dialog box:

· Select ENTER.


Activating Clicking Mode

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select On-Screen Keyboard.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to On-Screen Keyboard, and then press ENTER.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, press ENTER.

	2
	In the On-Screen Keyboard window, on the Settings menu:

· Select Typing Mode.
	In the On-Screen Keyboard window:

· Display the Settings menu by pressing ALT+S.

· Select Typing Mode by pressing T.

	3
	In the Typing Mode dialog box:

· Select Click to select.
	In the Typing Mode dialog box:

· Select Click to select by pressing ALT+K.

	4
	To close the Typing Mode dialog box:

· Select OK.
	To close the Typing Mode dialog box:

· Press ENTER.


Activating Scanning Mode

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select On-Screen Keyboard.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER. 

· Move to Accessibility, and then press ENTER.

· Move to On-Screen Keyboard, and then press ENTER.

Note  A message box with a link to more information about the On-Screen Keyboard may appear. To close the box, press ENTER.

	2
	In the On-Screen Keyboard window, on the Settings menu:

· Select Typing Mode.
	In the On-Screen Keyboard window:

· Display the Settings menu by pressing ALT+S.

· Select Typing Mode by pressing T.

	3
	In the Typing Mode dialog box:

· Select Joystick or key to select.
	In the Typing Mode dialog box:

· Select Joystick or key to select by pressing ALT+J.

	4
	To set the speed for how quickly On Screen Keyboard scans:

· Use the up and down arrows next to the Scan Interval box.

· Select the Advanced button.
	To set the speed for how quickly On Screen Keyboard scans:

· Press the TAB key.

· Use the arrow keys to select a scan interval.

· Select the Advanced button by pressing ALT+A.

	5
	In the Scanning Options dialog box:

· Select the Serial, parallel, or game port checkbox.

OR

· Select the Keyboard key checkbox.
	In the Scanning Options dialog box:

· Select the Serial, parallel, or game port checkbox by pressing S.

OR

· Select the Keyboard key checkbox by pressing K.

	6
	To close the dialog boxes:

· Select OK twice.
	To close the dialog boxes:

· Press ALT+O twice.


Using Magnifier

Magnifier is a display utility that makes the computer screen more readable for people who have low vision by creating a separate window that displays a magnified portion of the screen. Magnifier provides a minimum level of functionality for people who have slight visual impairments. Magnifier enables you to: 

· Adjust the magnification level of text and images in the magnification window. 

· Change the size and location of the magnification window. 

· Change the position of the magnification window on the desktop. 

· Invert the screen colors. 

· Use a high-contrast setting. 

Magnifier also has a number of tracking options, which include: 

· Following the mouse pointer as it moves on the screen. 

· Following the keyboard focus, which centers on the location of the cursor. 

· Following text editing. 

Step by Step Guides for Magnifier can help you with:

· Opening Magnifier. 

· Changing Magnifier to high contrast.

· Inverting the colors of the Magnifier windows. 

· Setting the magnification level.

· Setting Magnifier tracking options. 

· Changing the position of the Magnifier window. 

· Changing the size of the Magnifier window. 

Quick Reference: Opening Magnifier

	Start Menu Procedures

· Select the Start button, or press CTRL+ESC.

· Select Programs.

· Select Accessories.

· Select Accessibility.

· Select Magnifier.
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	Magnifier Settings Procedures

· Select the options you want.

· Optionally, select the Start Minimized button to hide the Magnifier Settings dialog box while you use Microsoft Magnifier.
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Opening Magnifier

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Magnifier.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, select OK.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, select the Minimize button. 
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER.

· Move to Accessibility, and then press ENTER.

· Move to Magnifier, and then press ENTER.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, press ENTER.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, press ALT+SPACEBAR, N.


To Continue

To continue customizing Magnifier, see one or more of the following Step by Step Guides:

· Changing Magnifier to High Contrast 

· Inverting the Colors of the Magnifier Window 

· Setting the Magnification Level 

· Setting Magnifier Tracking Options 

· Changing the Position of the Magnifier Window 

· Changing the Size of the Magnifier Window 

 Changing Magnifier to High Contrast

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Magnifier.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER.

· Move to Accessibility, and then press ENTER.

· Move to Magnifier, and then press ENTER.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, press ENTER.

	2
	In the Magnifier Settings dialog box, under Colors:

· Select Use High Contrast mode check box.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, select the Minimize button. 
	In the Magnifier Settings dialog box, under Colors:

· Select the Use High Contrast mode check box by pressing ALT+C.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, press ALT+SPACEBAR, N.


Inverting the Colors of the Magnifier Window

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Magnifier.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER.

· Move to Accessibility, and then press ENTER.

· Move to Magnifier, and then press ENTER.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, press ENTER.

	2
	In the Magnifier Settings dialog box, under Colors:

· Select the Invert Colors check box.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, select the Minimize button.
	In the Magnifier Settings dialog box, under Colors:

· Select the Invert Colors check box by pressing ALT+I.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, press ALT+SPACEBAR, N.


Setting the Magnification Level

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Magnifier.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER.

· Move to Accessibility, and then press ENTER.

· Move to Magnifier, and then press ENTER.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, press ENTER.

	2
	In the Magnifier Settings dialog box:

· Select Magnification Level.
	In the Magnifier Settings dialog box:

· Select the Magnification Level box by pressing ALT+L.

	3
	In the Magnification Level box:

· Adjust the level of magnification by typing a number from 1 to 9, or by using the arrows to select.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, select the Minimize button.
	In the Magnification Level box:

· Adjust the level of magnification by selecting a number from 1 to 9 using the UP ARROW or DOWN ARROW.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, press ALT+SPACEBAR, N.


Setting Magnifier Tracking Options

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Programs.

· Point to Accessories.

· Point to Accessibility.

· Select Magnifier.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, select OK.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Programs by pressing P.

· Move to Accessories by pressing the UP ARROW or DOWN ARROW key. Press ENTER.

· Move to Accessibility, and then press ENTER.

· Move to Magnifier, and then press ENTER.

Note  A message box with a link to more information about Microsoft Magnifier may appear. To close the box, press ENTER.

	2
	In the Magnifier Settings dialog box under Tracking:

· Select the appropriate option.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, select the Minimize button.
	In the Magnifier Settings dialog box:

· Press ALT+M. 

· Under Tracking, press the underlined access key to select the tracking option you want.

Note  To use Microsoft Magnifier but hide the Magnifier Settings dialog box, press ALT+SPACEBAR, N.


Changing the Position of the Magnifier Window

	
	Mouse actions
	Keyboard actions

	1
	When Microsoft Magnifier is running:

· Move the pointer over the Magnifier window.
	When Microsoft Magnifier is running:

· Make sure MouseKeys is turned on.

· Move the pointer over the Magnifier window by pressing the arrow keys on your numeric keypad.

	2
	To move the Magnifier window:

· Hold down the left mouse button and drag the Magnifier window to reposition it. 
	To move the Magnifier window:

· Press the INS key on your numeric keypad.

· Drag the Magnifier window to reposition it by pressing the arrow keys on your numeric keypad.

· Press the DEL key on your numeric keypad.


Changing the Size of the Magnifier Window

	
	Mouse actions
	Keyboard actions

	1
	When Microsoft Magnifier is running:

· Move the mouse pointer over an edge of the Magnifier window.
	When Microsoft Magnifier is running:

· Make sure MouseKeys is turned on.

· Move the pointer over an edge of the Magnifier window by pressing the arrow keys on your numeric keypad.

	2
	When the cursor becomes a double-pointed arrow:

· Hold down the left mouse button and drag the Magnifier window border to resize the window.
	When the cursor becomes a double-pointed arrow:

· Pressing the INS key on your numeric keypad.

· Press the arrow keys on your numeric keypad to adjust the window to the size you want.

· Press the DEL key on your numeric keypad.


Adjusting Settings Through Control Panel

You can make adjustments to most of the accessibility features of Microsoft Windows Me by using Control Panel. By selecting just one icon in Control Panel—the Accessibility Options icon—you can adjust most of the accessibility settings all in one place. 

Step by Step Guides can help you with:

· Adjusting Accessibility Options.

· Turning StickyKeys on and off.

· Selecting StickyKeys settings.

· Turning FilterKeys on and off.

· Selecting FilterKeys settings.

· Turning ToggleKeys on and off.

· Selecting ToggleKeys settings.

· Showing extra keyboard help in programs.

· Turning SoundSentry on and off.

· Selecting SoundSentry settings.

· Turning ShowSounds on and off.

· Turning high contrast on and off.

· Selecting high contrast settings.

· Turning MouseKeys on and off.

· Selecting MouseKeys settings.

· Turning off Accessibility features after computer is idle for specified number of minutes.

· Enabling a warning message to appear when turning a feature on.

· Enabling a warning sound to play when turning a feature on or off.

· Supporting SerialKeys devices.

· Selecting SerialKeys settings.

Adjusting Accessibility Options

Selecting the Accessibility Options icon gives you access to most of the accessibility settings in Windows Me. When you select Accessibility Options, you'll find the settings grouped on these tabs: Keyboard, Sound, Display, Mouse, and General.

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

To access keyboard settings:

· Select the Keyboard tab.

To access sound settings:

· Select the Sound tab.

To access display settings:

· Select the Display tab.

To access mouse settings:

· Select the Mouse tab.

To access other accessibility settings:

· Select the General tab.
	In the Accessibility Properties dialog box, select a tab by pressing CTRL+TAB.

To access keyboard options:

· Select the Keyboard tab.

To access sound options:

· Select the Sound tab.

To access display options:

· Select the Display tab.

To access mouse options:

· Select the Mouse tab.

To access other accessibility options:

· Select the General tab.


To Continue

To continue customizing Accessibility Options, select the appropriate tab and see the following Step by Step Guides:

On the Keyboard tab:

· Turning StickyKeys On and Off

· Selecting StickyKeys Settings

· Turning FilterKeys On and Off

· Selecting FilterKeys Settings

· Turning ToggleKeys On and Off

· Selecting ToggleKeys Settings

· Showing Extra Keyboard Help in Programs

On the Sound tab:

· Turning SoundSentry On and Off

· Selecting SoundSentry Settings

· Turning ShowSounds On and Off

On the Display tab:

· Turning High Contrast On and Off

· Selecting High Contrast Settings

· Setting the Cursor Blink Rate

· Setting the Cursor Width

On the Mouse tab:

· Turning MouseKeys On and Off

· Selecting MouseKeys Settings

On the General tab:

· Turning Off Accessibility Features After Computer Is Idle for Specified Number of Minutes

· Enabling a Warning Message to Appear When Turning a Feature On

· Enabling a Warning Sound to Play When Turning a Feature On and Off

· Supporting SerialKeys Devices

· Selecting SerialKeys Settings

Turning StickyKeys On and Off

StickyKeys is designed for people who have difficulty holding down two or more keys at a time. When a shortcut requires a key combination such as CTRL+P, StickyKeys will enable you to press one key at a time instead of pressing them simultaneously. 

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Keyboard tab.
	In the Accessibility Properties dialog box:

· Move to the Keyboard tab by pressing CTRL+TAB.

	4
	On the Keyboard tab:

To turn on StickyKeys:

· Select the Use StickyKeys check box. 

OR

To turn off StickyKeys:

· Clear the Use StickyKeys check box.

· Select OK.
	On the Keyboard tab:

To turn on StickyKeys:

· Select the Use StickyKeys check box by pressing U. 

OR

To turn off StickyKeys:

· Clear the Use StickyKeys check box by pressing U.

· Press ENTER. 

	4
	To close Control Panel, on the File menu: 
· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Selecting StickyKeys Settings

StickyKeys is designed for people who have difficulty holding down two or more keys at a time. When a shortcut requires a key combination such as CTRL+P, StickyKeys enables you to press one key at a time instead of pressing them simultaneously. This Step by Step Guide helps you adjust StickyKeys settings.

	Accessibility Properties: Keyboard tab
	Settings for StickyKeys dialog box
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, then press ENTER.


(continued)

	3
	In the Accessibility Properties dialog box:

· Select the Keyboard tab.
	In the Accessibility Properties dialog box:

· Move to the Keyboard tab by pressing CTRL+TAB.

	4
	On the Keyboard tab:

· Select the Use StickyKeys check box. 
	On the Keyboard tab:

· Select the Use StickyKeys check box by pressing U.

	5
	To access StickyKeys settings:

· Select Settings.
	To access StickyKeys settings:

· Select Settings by pressing S.

	6
	In the Settings for StickyKeys dialog box:

· Select the options you want by selecting or clearing the check boxes.

· Select OK twice to save the settings and exit Accessibility Properties.
	In the Settings for StickyKeys dialog box:

· Select options by pressing the underlined access keys.

· Press ENTER twice to save the settings and exit Accessibility Properties.

	7
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Turning FilterKeys On and Off

FilterKeys adjust the keyboard response so that inadvertently repeated keystrokes are ignored.

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Keyboard tab.
	In the Accessibility Properties dialog box:

· Move to the Keyboard tab by pressing CTRL+TAB.

	4
	On the Keyboard tab, to turn on FilterKeys:

· Select the Use FilterKeys check box. 

OR

To turn off FilterKeys:

· Clear the Use FilterKeys check box.

· Select OK.
	On the Keyboard tab:

To turn on FilterKeys, select the Use FilterKeys check box by pressing F. 

OR

To turn off FilterKeys:

· Clear the Use FilterKeys check box by pressing F.

· Press ENTER. 

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Selecting FilterKeys Settings

When FilterKeys is turned on, multiple keystrokes to one key are ignored within a certain timeframe. You can select the timeframe using FilterKeys settings.

	Accessibility Properties: Keyboard tab
	Settings for FilterKeys dialog box
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Accessibility Properties dialog box:

· Select the Keyboard tab.
	In the Accessibility Properties dialog box:

· Move to the Keyboard tab by pressing CTRL+TAB.

	4
	On the Keyboard tab:

· Select the Use FilterKeys check box. 
	On the Keyboard tab:

· Select the Use FilterKeys check box by pressing F.

	5
	To access FilterKeys settings:

· Select Settings.
	To access FilterKeys settings:

· Select Settings by pressing E.

	6
	In the Settings for FilterKeys dialog box:

· Select the options you want.

· Select OK twice to save the settings and exit Accessibility Properties.
	In the Settings for FilterKeys dialog box:

· Select options by pressing the underlined access keys.

· Press ENTER twice to save the settings and exit Accessibility Properties.

	7
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Turning ToggleKeys On and Off

When ToggleKeys is turned on, a sound is emitted when locking keys (CAPS LOCK, NUM LOCK, and SCROLL LOCK) are pressed.

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Keyboard tab.
	In the Accessibility Properties dialog box:

· Move to the Keyboard tab by pressing CTRL+TAB.

	4
	On the Keyboard tab:

To turn on ToggleKeys:

Select the Use ToggleKeys check box. 

OR

To turn off ToggleKeys:

· Clear the Use ToggleKeys check box.

· Select OK.
	On the Keyboard tab:

To turn on ToggleKeys:

Select the Use ToggleKeys check box by pressing T. 

OR

To turn off ToggleKeys:

· Clear the Use ToggleKeys check box by pressing T.

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Selecting ToggleKeys Settings

When ToggleKeys is turned on, a sound is emitted when locking keys (CAPS LOCK, NUM LOCK, and SCROLL LOCK) are pressed. Use this Step by Step Guide to adjust ToggleKeys settings.

	Accessibility Properties: Keyboard tab
	Settings for ToggleKeys dialog box
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Accessibility Properties dialog box:

· Select the Keyboard tab.
	In the Accessibility Properties dialog box:

· Move to the Keyboard tab by pressing CTRL+TAB.

	4
	On the Keyboard tab:

· Select the Use ToggleKeys check box.
	On the Keyboard tab:

· Select the Use ToggleKeys check box by pressing T. 

	5
	To specify use of the shortcut:

· Select Settings.
	To specify use of the shortcut:

· Select Settings by pressing N.

	6
	In the Settings for ToggleKeys dialog box:

To use the shortcut key for ToggleKeys:

· Select the check box.

· Select OK twice to save the settings and exit Accessibility Properties.
	In the Settings for ToggleKeys dialog box:

To use the shortcut key for ToggleKeys (if it is not already checked):

· Select the check box by typing S.

· Press ENTER twice to save the settings and exit Accessibility Properties.

	7
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Showing Extra Keyboard Help in Programs

When this option is selected extra keyboard help is displayed in programs where it is available. 

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the UP ARROW or DOWN ARROW key.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Keyboard tab.
	In the Accessibility Properties dialog box:

· Move to the Keyboard tab by pressing CTRL+TAB.

	4
	On the Keyboard tab:

· Select the Show extra keyboard help in programs check box.

· Select OK.
	On the Keyboard tab:

· Select the Show extra keyboard help in programs check box by pressing W. 

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Turning SoundSentry On and Off
SoundSentry allows you to change the settings to generate visual warnings, such as a blinking title bar or a screen flash, whenever the computer you are using generates a sound. You will be able to choose visual warnings (for example, a flashing border) for sounds made by windowed programs and for sounds made by full screen text programs.

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Sound tab.
	In the Accessibility Properties dialog box:

· Move to the Sound tab by pressing CTRL+TAB.

	4
	On the Sound tab:

To turn on SoundSentry:

· Select the Use SoundSentry check box. 

Or

To turn off SoundSentry:

· Clear the Use SoundSentry check box.

· Select OK.
	On the Sound tab:

To turn on SoundSentry:

· Select the Use SoundSentry check box by pressing ALT+S. 

Or

To turn off SoundSentry:

· Clear the Use SoundSentry check box by pressing ALT+S.

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Selecting SoundSentry Settings

SoundSentry allows you to change settings to generate visual warnings, such as a blinking title bar or a flashing border, whenever your computer generates a sound. You can choose visual warnings for sounds made by windowed programs and for sounds made by full-screen text programs. Use this Step by Step Guide to adjust SoundSentry settings.

	Accessibility Properties: Sound tab
	Settings for SoundSentry dialog box
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	Mouse actions
	Keyboard actions

	1
	On the Start menu, point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Sound tab.
	In the Accessibility Properties dialog box:

· Select the Sound tab by pressing CTRL+TAB.

	4
	On the Sound tab:

· Select the Use SoundSentry check box.

· Select Settings.
	On the Sound tab:

· Select the Use SoundSentry check box by pressing ALT+S.

· Select Settings by pressing E.

	5
	In the Settings for SoundSentry dialog box:

· Select the visual warning you want.

· Select OK twice to close the dialog boxes.
	In the Settings for SoundSentry dialog box:

· Select the visual warning you want by using the UP ARROW or DOWN ARROW key.

· Press ENTER twice to close the dialog boxes.

	6
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Turning ShowSounds On and Off

When ShowSounds is on, you can see captions for speech or other sounds generated by your computer programs.

	Accessibility Properties: Sound tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Sound tab.
	In the Accessibility Properties dialog box:

· Select the Sound tab by pressing CTRL+TAB.

	4
	On the Sound tab:

To turn on ShowSounds:

· Select the Use ShowSounds check box. 

OR

To turn off ShowSounds:

· Clear the Use ShowSounds check box.

· Select OK.
	On the Sound tab:

To turn on ShowSounds:

· Select the Use ShowSounds check box by pressing ALT+H. 

OR

To turn off ShowSounds:

· Clear the Use ShowSounds check box by pressing ALT+H.

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Turning High Contrast On and Off

High contrast color schemes can make the screen easier to view for some users by heightening screen contrast with alternative color combinations and font sizes.

	Accessibility Options: Display tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Display tab.
	In the Accessibility Properties dialog box:

· Move to the Display tab by pressing CTRL+TAB.

	4
	On the Display tab:

To turn on High Contrast:

· Select the Use High Contrast check box. 

OR

To turn off High Contrast:

· Clear the Use High Contrast check box.

· Select OK.
	On the Display tab:

To turn on High Contrast:

· Select the Use High Contrast check box by pressing ALT+U. 

OR

To turn off High Contrast:

· Clear the Use High Contrast check box by pressing ALT+U. 

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Selecting High Contrast Settings

High contrast color schemes can make the screen easier to view for some users by heightening screen contrast with alternative color combinations and font sizes. Use this Step by Step Guide to adjust High Contrast settings.

	Accessibility Properties: Display tab
	Settings for High Contrast dialog box
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Accessibility Properties dialog box:

· Select the Display tab.
	In the Accessibility Properties dialog box:

· Move to the Display tab by pressing CTRL+TAB.

	4
	On the Display tab:

· Select the Use High Contrast check box. 
	On the Display tab:

· Select the Use High Contrast check box by pressing ALT+U. 

	5
	To access High Contrast settings:

· Select Settings.
	To access High Contrast settings:

· Select Settings by pressing S.

	6
	In the Settings for High Contrast dialog box:

· Select the options you want.

· Select OK twice to save your settings and close the dialog boxes.
	In the Settings for High Contrast dialog box:

· Select the options you want by using the underlined access keys.

· Press ENTER twice to save your settings and close the dialog boxes.

	7
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Adjusting Cursor Settings

You can adjust the blink rate of your cursor and its width on screen. These options can help make the cursor easier to see on screen or less distracting if you want. Use this Step by Step Guide to adjust cursor settings.

	Accessibility Properties: Display tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click Accessibility Options.
	In Control Panel:

· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Accessibility Properties dialog box:

· Select the Display tab.
	In the Accessibility Properties dialog box:

· Move to the Display tab by pressing CTRL+TAB.

	4
	In the Cursor Settings area:

· Adjust the Cursor Blink Rate by moving the slider left for slower, right for faster.

· Adjust the Cursor Width by moving the slider left for narrower, right for wider.

· Select OK twice to save your settings and close the dialog boxes.
	In the Cursor Settings area:

· Move to Cursor Blink Rate by pressing ALT+R, then adjust the setting from slow to fast by using the LEFT ARROW or RIGHT ARROW key.

· Move to Cursor Width by pressing ALT+W, then adjust the setting from narrow to wide by using the LEFT ARROW or RIGHT ARROW key.

· Press ENTER twice to save your settings and close the dialog boxes.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Turning MouseKeys On and Off

When MouseKeys is on, you can use the numeric keypad for data entry as well as for navigation. 

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.

	2
	In Control Panel:  

· Double-click Accessibility Options.
	In Control Panel:
· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the Mouse tab.
	In the Accessibility Properties dialog box:

· Move to the Mouse tab by pressing CTRL+TAB.

	4
	On the Mouse tab:

To turn on MouseKeys:

· Select the Use MouseKeys check box. 

OR

To turn off MouseKeys:

· Clear the Use MouseKeys check box. 

· Select OK.
	On the Mouse tab:

To turn on MouseKeys:

· Select the Use MouseKeys check box by pressing ALT+M. 

OR

To turn off MouseKeys:

· Clear the Use MouseKeys check box by pressing ALT+M. 

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Selecting MouseKeys Settings

When MouseKeys is on, you can use the numeric keypad for data entry as well as for navigation. Use this Step by Step Guide to adjust MouseKeys settings.

	Accessibility Properties: Mouse tab
	Settings for MouseKeys dialog box
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.

	2
	In Control Panel:  

· Double-click Accessibility Options.
	In Control Panel:
· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Accessibility Properties dialog box:

· Select the Mouse tab.
	In the Accessibility Properties dialog box:

· Move to the Mouse tab by pressing CTRL+TAB.

	4
	On the Mouse tab:

· Select Use MouseKeys.

· Select Settings.
	On the Mouse tab:

· Select Use MouseKeys by pressing ALT+M.

· Select Settings by pressing S.

	5
	In the Settings for MouseKeys dialog box:

· Select the options you want.

· Select OK twice to save your settings and close the dialog boxes.
	In the Settings for MouseKeys dialog box:

· Select the options you want by using the underlined access keys, and the arrow keys.

· Press ENTER twice to save your settings and close the dialog boxes.

	6
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Turning Off Accessibility Features After Computer Is Idle 

When this option is selected, the accessibility features you have used while working will be turned off after a specified number of minutes. This benefits people who share a computer and want to customize it to their personal preferences.

	Accessibility Properties: General tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.

	2
	In Control Panel:  

· Double-click Accessibility Options.
	In Control Panel:
· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the General tab.
	In the Accessibility Properties dialog box:

· Select the General tab by pressing CTRL+TAB.

	4
	On the General tab:

· Select the Turn off accessibility features after idle for check box.

In the minutes box:

· Select the idle time.

· Select OK.
	On the General tab:

· Select the Turn off accessibility features after idle for check box by pressing ALT+T.

· Specify the idle time by pressing the TAB key and using the arrow keys to select the number of minutes.

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Enabling a Warning Message to Appear When Turning a Feature On

When this option is selected, a warning message will appear when a feature is turned on. This is helpful in situations where a computer is shared, or when one user sometimes works with a particular feature turned on and other times does not.

	Accessibility Properties: General tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.

	2
	In Control Panel:  

· Double-click Accessibility Options.
	In Control Panel:
· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the General tab.
	In the Accessibility Properties dialog box:

· Move to the General tab by pressing CTRL+TAB.

	4
	On the General tab: 

· Select the Give warning message when turning a feature on check box.

· Select OK.
	On the General tab:

· Select the Give warning message when turning a feature on check box by pressing G. 

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Enabling a Warning Sound to Play When Turning a Feature On or Off

When this option is selected, a warning sound is given when a feature is turned on or off. This can benefit all users, and in particular those with visual impairments.

	Accessibility Properties: General tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:  

· Double-click Accessibility Options.
	In Control Panel:
· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the General tab.
	In the Accessibility Properties dialog box:

· Move to the General tab by pressing CTRL+TAB.

	4
	On the General tab: 

· Select the Make a sound when turning a feature on or off check box.

· Select OK.
	On the General tab:

· Select the Make a sound when turning a feature on or off check box by pressing S. 

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Supporting SerialKeys Devices

This feature allows the use of alternative input devices such as augmentative speech devices.

	
	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.

	2
	In Control Panel:  

· Double-click Accessibility Options.
	In Control Panel:
· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Accessibility Properties dialog box:

· Select the General tab.
	In the Accessibility Properties dialog box:

· Move to the General tab by pressing CTRL+TAB.

	4
	On the General tab:

· Select the Support SerialKey devices check box.

· Select OK.
	On the General tab:

· Select the Support SerialKey devices check box by pressing ALT+U.

· Press ENTER.

	5
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Selecting SerialKeys Settings

When this feature is turned on, alternative access to keyboard and mouse features by augmentative speech devices or other alternative input devices is enabled. Use this Step by Step Guide to adjust SerialKeys settings.

	Accessibility Properties: General tab
	Settings for SerialKeys dialog box
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel: 

· Double-click Accessibility Options.
	In Control Panel:
· Select the Accessibility Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Accessibility Properties dialog box:

· Select the General tab.
	In the Accessibility Properties dialog box:

· Move to the General tab by pressing CTRL+TAB.

	4
	On the General tab:

· Select the Support SerialKey Devices check box.

· Select Settings.
	On the General tab:

· Select the Support SerialKey Devices check box by pressing ALT+U.

· Select Settings by pressing E.

	5
	In the Settings for SerialKeys dialog box:

· Select the options you want.

· Select OK.
	In the Settings for SerialKeys dialog box:

· Select options using the underlined access keys and the arrow keys.

· Press ENTER.

	6
	To close Control Panel, on the File menu:

· Select Close.
	To close Control Panel:

· Press ALT+F, C.


Using Other Control Panel Options Programs

In addition to using the Accessibility Options icon in Control Panel, you can use nine other icons to further customize accessibility options. 

Selecting these icons will help you with:

· Adjusting display options.

· Adjusting folder options.

· Adjusting Internet options.

· Adjusting keyboard options.

· Adjusting mouse options.

· Adjusting passwords options.

· Adjusting sounds and multimedia options.

· Adjusting taskbar and Start menu options.

· Adjusting users  options.

Adjusting Display Options

Select the Display icon in Control Panel to customize your desktop display including selecting screen elements and schemes, adjusting the screen area and font sizes, selecting a screen saver, changing the size and color of your icons, and smoothing the edges of screen fonts.

	Display Properties: Appearance tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:

· Double-click the Display icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:
· Select the Display icon by using the arrow keys. 

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Display Properties dialog box, select the appropriate tab:

To make changes to screen elements and schemes:

· Select the Appearance tab.

To change the size and color of your icons, and to smooth the edges of screen fonts:

· Select the Effects tab.

To adjust the screen area and font sizes:

· Select the Settings tab.
	In the Display Properties dialog box:

· Move to the appropriate tab by pressing CTRL+TAB:

To make changes to screen elements and schemes:

· Select the Appearance tab.

To change the size and color of your icons, and to smooth the edges of screen fonts:

· Select the Effects tab.

To adjust the screen area and font sizes:

· Select the Settings tab.


Adjusting Folder Options

Select the Folder Options icon in Control Panel to change settings for Web and folder views, the number of clicks required to open items, and advanced files and folders settings.

	Folder Properties: General tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:

· Double-click the Folder icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:
· Select the Folder icon by using the arrow keys. 

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Folder Properties dialog box:

· Select the appropriate tab:

To make changes to the Active Desktop, Web and folder views, the number of clicks to open items, and more:

· Select the General tab.

To change folder views and select advanced files and folders settings:

· Select the View tab.

To view, select, add, and delete registered file types:

· Select the File Types tab.
	In the Folder Properties dialog box:

· Move to the appropriate tab by pressing CTRL+TAB.

To make changes to the Active Desktop, Web and folder views, the number of clicks to open items, and more:

· Select the General tab.

To change folder views and select advanced files and folders settings:

· Select the View tab.

To view, select, add, and delete registered file types:

· Select the File Types tab.


Adjusting Internet Options

Select the Internet Options icon in Control Panel to configure your Internet display and connections settings including adjusting settings for Web pages and style sheets, expanding ALT text for images, and moving the system caret with focus/selection changes.

	Internet Properties: General tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:  

· Double-click Internet Options.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:
· Select the Internet Options icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, then press ENTER.

	3
	In the Internet Properties dialog box:

· Select the appropriate tab:

To adjust settings for Web pages and style sheets:

· Select the Accessibility button on the General tab.

To expand ALT text for images and move the system caret with focus/selection changes, and more:

· Select the Advanced tab.
	In the Internet Properties dialog box:

· Move to the appropriate tab by pressing CTRL+TAB (continue pressing TAB until you reach the desired tab):

To adjust settings for Web pages and style sheets:

· Select the Accessibility button on the General tab.

To expand ALT text for images and move the system caret with focus/selection changes, and more:

· Select the Advanced tab.


Adjusting Keyboard Options

Select the Keyboard icon in Control Panel to customize keyboard settings such as adjusting the character repeat rate, repeat-delay speed, and the cursor blink rate.

	Keyboard Properties: Speed tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key): 

· Move to Settings by pressing S.  

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:  

· Double-click the Keyboard icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:
· Select the Keyboard icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, then press ENTER.

	3
	In the Keyboard Properties dialog box:

· Select the appropriate tab:

To adjust the character repeat rate, repeat-delay speed, and the cursor blink rate:

· Select the Speed tab.

To specify the installed keyboard languages and layouts:

· Select the Language tab.
	In the Keyboard Properties dialog box:

· Move to the appropriate tab by pressing CTRL+TAB (continue pressing TAB until you reach the desired tab):

To adjust the character repeat rate, repeat-delay speed, and the cursor blink rate:

· Select the Speed tab.

To specify the installed keyboard languages and layouts:

· Select the Language tab.


Adjusting Mouse Options

Select the Mouse icon in Control Panel to customize mouse settings such as choosing right-handed or left-handed mouse button configuration, adjusting double-click speed, and turning on the ClickLock feature. Mouse options also allow you to change the pointer scheme, adjust the pointer speed and acceleration rate, and choose options such as showing pointer trails, hiding the pointer while typing, showing the location of the pointer, and turning on the SnapTo feature.

	Mouse Properties: Buttons tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:

· Double-click the Mouse icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:

· Select the Mouse icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, then press ENTER.


	3
	In the Mouse Properties dialog box:

· Select the appropriate tab:

To choose right-handed or left-handed mouse button configuration, adjust double-click speed, and turn on ClickLock:

· Select the Buttons tab.

To change the pointer scheme:

· Select the Pointers tab.

To adjust the pointer speed and acceleration rate, or to choose options such as showing pointer trails, hiding the pointer while typing, showing the location of the pointer, and turning on SnapTo:

· Select the Pointer Options tab.
	In the Mouse Properties dialog box:

· Select the appropriate tab by pressing CTRL+TAB (continue pressing TAB until you reach the desired tab):

To choose right-handed or left-handed mouse button configuration, adjust double-click speed, and turn on ClickLock:

· Select the Buttons tab.

To change the pointer scheme:

· Select the Pointers tab.

To adjust the pointer speed and acceleration rate, or to choose options such as showing pointer trails, hiding the pointer while typing, showing the location of the pointer, and turning on SnapTo:

· Select the Pointer Options tab.


Adjusting Passwords Options

Select the Passwords icon in Control Panel to grant or deny access to your computer, to change passwords, to allow preferences and desktop settings to be customized for users, and other password settings.

	Passwords: Change Passwords tab
	Passwords: User Profile tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click the Passwords icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:

· Select the Passwords icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Passwords dialog box:

· Select the appropriate tab:

To grant or deny access to your computer and to change passwords and other settings:

· Select the Change Passwords tab.

To allow preferences and desktop settings to be customized for users:

· Select the User Profiles tab. 
	In the Passwords dialog box:

· Select the appropriate tab by pressing CTRL+TAB:

To grant or deny access to your computer and to change passwords and other settings:

· Select the Change Passwords tab.

To allow preferences and desktop settings to be customized for users:

· Select the User Profiles tab.


Adjusting Sounds and Multimedia Options

Select the Sounds and Multimedia icon in Control Panel to change sounds and multimedia settings such as:  assigning sounds to events, choosing sound schemes, sound volume, showing volume control in the taskbar, and selecting audio devices.

	Sounds and Multimedia Properties: Sounds tab
	Sounds and Multimedia Properties: Audio tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.


(continued)

	2
	In Control Panel:

· Double-click the Sounds and Multimedia icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:

· Select the Sounds and Multimedia icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.

	3
	In the Sounds and Multimedia Properties dialog box:

· Select the appropriate tab:

To assign sounds to events, choose sound schemes, choose sound volume, choose show volume control in the taskbar:

· Select the Sounds tab.

To select and configure audio devices on your computer:

· Select the Audio tab.

To specify the preferred voice playback and voice capture devices:

· Select the Voice tab.

To choose multimedia devices:

· Select the Devices tab.
	In the Sounds and Multimedia Properties dialog box:

· Select the appropriate tab by pressing CTRL+TAB:

To assign sounds to events, choose sound schemes, choose sound volume, choose show volume control in the taskbar:

· Select the Sounds tab.

To select and configure audio devices on your computer:

· Select the Audio tab.

To specify the preferred voice playback and voice capture devices:

· Select the Voice tab.

To choose multimedia devices:

· Select the Devices tab.


Adjusting Taskbar and Start Menu Options

Select the Taskbar and Start Menu Options icon in Control Panel to select Start menu options such as: always display the Start menu on top, hide the Start menu, show the clock, and use personalized menus, and to customize the Start menu and taskbar.

	Taskbar and Start Menu Properties: General tab
	Taskbar and Start Menu Properties: Advanced tab
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click the Taskbar and Start Menu icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:

· Select the Taskbar and Start Menu icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Taskbar and Start Menu Properties dialog box:

· Select the appropriate tab:

To select Start menu options such as: always display the Start menu on top, hide the Start menu, show the clock, and use personalized menus:

· Select the General tab.

To customize the Start menu and taskbar by adding or removing items and adjusting other options:

· Select the Advanced tab.
	In the Taskbar and Start menu Properties dialog box:

· Select the appropriate tab by pressing CTRL+TAB:

To select Start menu options such as: always display the Start menu on top, hide the Start menu, show the clock, and use personalized menus:

· Select the General tab.

To customize the Start menu and taskbar by adding or removing items and adjusting other options:

· Select the Advanced tab.


Adjusting Users Options

Select the Users icon in Control Panel to enter new names and passwords to allow other people to use your computer with personalized settings associated with their users names and passwords.

	Enable Multi-user Settings
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	Mouse actions
	Keyboard actions

	1
	On the Start menu:

· Point to Settings.

· Select Control Panel.
	· Display the Start menu by pressing CTRL+ESC (or the Windows logo key):

· Move to Settings by pressing S.

· Select Control Panel by pressing C.

	2
	In Control Panel:

· Double-click the Users icon.

Note  If all of the Control Panel icons are not displayed, select view all Control Panel options.
	In Control Panel:

· Select the Users icon by using the arrow keys.

· Press ENTER.

Note  If all of the Control Panel icons are not displayed, press the TAB key until view all Control Panel options is selected, and then press ENTER.


(continued)

	3
	In the Enable Multi-user Settings dialog box:

· Select Next if you want to allow other people to use your computer with personalized settings associated with their users names and passwords.

· Continue through the wizard entering appropriate names and passwords for additional users. 
	In the Enable Multi-user Settings dialog box:

· Press N if you want to allow other people to use your computer with personalized settings associated with their users names and passwords.

· Continue through the wizard entering appropriate names and passwords for additional users.
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